
 

IP Office 
SoftConsole Users Guide 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

40DHB0002USEJ Issue 1 (23rd September 2003)





 

i 

Table Of Contents 
Introduction............................................................................................................................................... 1 

Overview of SoftConsole ........................................................................................................................................1 
Getting Started........................................................................................................................................................2 
Main Window ..........................................................................................................................................................3 
Main Menu Bar .......................................................................................................................................................5 
Call Details Panel ...................................................................................................................................................6 
Directory Entry Forms.............................................................................................................................................8 
Directory Entry Properties Form.............................................................................................................................9 
Forwarding Status Form .......................................................................................................................................10 
External Directory Entry Form ..............................................................................................................................11 
Group Service Status............................................................................................................................................11 
BLF Panel .............................................................................................................................................................12 

BLF Panel Views ..........................................................................................................................................................................................13 
Add Members to a BLF Group..............................................................................................................................14 
Views ....................................................................................................................................................................14 

Call Handling........................................................................................................................................... 15 
Incoming Call Handling.........................................................................................................................................15 
Scripts...................................................................................................................................................................17 
Reclaim Calls........................................................................................................................................................17 
Transfer a Call (Unsupervised).............................................................................................................................18 
Transfer a Call (Supervised).................................................................................................................................19 

To make a Consultation Call.........................................................................................................................................................................19 
Transfer a call to Voicemail ..................................................................................................................................20 
Making an outgoing call ........................................................................................................................................20 
Using Hold ............................................................................................................................................................21 

Held Calls Panel ...........................................................................................................................................................................................22 
Hold against a busy extension......................................................................................................................................................................23 
Hold Current Call and Auto Answer Next Call ..............................................................................................................................................23 

Reattempt Transfer...............................................................................................................................................23 
Parking a Call .......................................................................................................................................................24 
Collect a parked call .............................................................................................................................................25 
Working with Queues............................................................................................................................................26 

Monitor a Queue ...........................................................................................................................................................................................26 
Answer a Queued Call..................................................................................................................................................................................26 

Conference Calls ..................................................................................................................................................27 
Conference Held Calls..................................................................................................................................................................................27 
Conference Room.........................................................................................................................................................................................28 

Features................................................................................................................................................... 31 
Annotate ...............................................................................................................................................................33 
Intrude...................................................................................................................................................................33 
Page .....................................................................................................................................................................34 
Record Call ...........................................................................................................................................................35 
Send Message......................................................................................................................................................36 
Reattempt Transfer...............................................................................................................................................36 
Using Dial Pad ......................................................................................................................................................37 
Door Release........................................................................................................................................................38 

Configuration ................................................................................................................................................................................................38 
Send Email ...........................................................................................................................................................38 



Table Of Contents 

ii 

Administration ........................................................................................................................................ 39 
Login Form............................................................................................................................................................39 
IP Office Control Units ..........................................................................................................................................40 
Administrator Functionality ...................................................................................................................................41 
Change Administrator Password ..........................................................................................................................42 
Configuration Form...............................................................................................................................................43 
Incoming Calls Configuration................................................................................................................................44 
Local Directory List ...............................................................................................................................................45 

Create a New Entry. .....................................................................................................................................................................................45 
Edit an Existing Entry....................................................................................................................................................................................45 

Configuring a Queue.............................................................................................................................................46 
Recall Queue ........................................................................................................................................................47 
New/Edit Queue....................................................................................................................................................47 
Park Slots Configuration.......................................................................................................................................48 
New/Edit Park Slot................................................................................................................................................48 
BLF Groups Configuration....................................................................................................................................49 

Create a New BLF Group .............................................................................................................................................................................49 
Edit a BLF Group ..........................................................................................................................................................................................49 

Directories Configuration ......................................................................................................................................50 
Conferencing Configuration..................................................................................................................................52 
Keyboard Mapping Configuration .........................................................................................................................52 
Keyboard Actions Configuration ...........................................................................................................................53 
Appearance Configuration....................................................................................................................................54 
Save Configuration ...............................................................................................................................................54 

Appendix ................................................................................................................................................. 55 
Default Templates.................................................................................................................................................57 
Short Cut Keys......................................................................................................................................................58 
Toolbar Buttons ....................................................................................................................................................61 
Glossary................................................................................................................................................................63 

Index ........................................................................................................................................................ 65 



 Page 1 

SoftConsole Users Guide Page 1 
IP Office 40DHB0002USEJ Issue 1 (23rd September 2003) 

Introduction 
Overview of SoftConsole 
Key Features of SoftConsole are: 

• PC based operator console. 

• Simple keyboard operation. 

• Large display for incoming calls and extension status information. 

• Bar graphs give a visual display of queued calls. 

• Visual display of the status of extensions. 

• Up to 16 call parking areas. 

 

SoftConsole combines all the elements needed to make your business communications successful.  This 
success depends upon people and their ability to communicate quickly, efficiently and effectively.   

 

• Enhanced Call Handling 
The PC based SoftConsole is designed to benefit your business through improved Operator service. 
 Scripts can be installed giving the operator information about the incoming call.   

• Ease-of-Use 
SoftConsole is designed to be easy to use. Its look and feel will appeal to experienced and novice 
operators alike. 

 

Note:  This manual has been written assuming:  

• Voicemail is installed on the IP Office. 

• SoftConsole is operating with the Default settings as supplied with AdminTemplate1. 
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Getting Started 
1. From the Windows Start Button, select Programs. 

2. Highlight IP Office then click SoftConsole.   

 

When a SoftConsole session is started a Login Form shows containing operator profiles.   

1. Select the desired profile.  
Each Operator has their own profile.  The profile contains information on the configuration 
preferences and connection to the telephone system. The chosen profile is the default profile the 
next time SoftConsole is started. 

2. Enter your user name & password. 

3. Click OK. 

 

Note:  If directory access to Microsoft Outlook contacts folder has been selected in the directories 
configuration form, a Microsoft Outlook warning screen might appear.  If the warning screen appears: 

1. Select the Allow access for checkbox, and then click an amount of time in the list. 

2. Click Yes. Yes should always be selected to allow SoftConsole to retrieve Outlook contacts. 

 

Refer to the Login Form section for more details. 
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Main Window 
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The SoftConsole main screen is divided into the following areas: 

• Main Menu Bar: Commands & actions are available through menus.  Some items are only 
accessible when the right conditions occur e.g. when a call is received. 

• Toolbars: The toolbars provide short cuts for options that are frequently used. 

• Call Details Panel: The panel contains a side-by-side display of current call information. The panel 
on the left shows details of the current call. The panel on the right shows the directory, individual 
extension details or details of a consultation call.  It can also show a script file and conferencing 
information.  

• Queue Panel: The Queue panel displays graphical information on the status of calls held in queues. 

• Held Calls Panel: All calls held at the operator station appear as a list in the Held Calls Panel. 

• BLF Panel: (Busy Lamp Field Panel) Icons indicate the status of selected users.  Tabs indicate 
different groups of BLF icons, depending on how the BLF details are configured.  

• Park Slot Panel: The panel contains up to 16 Park Slots with specific Park ID. 

• Status Bar: Shows current status of the system.  The bar is divided into four sections that display: 

• The current connection status 

• The current Profile name 

• Information messages, e.g. alarm conditions. 

• The number of new Voicemail messages for the operator.  Double click in this area to call the 
operator's Voicemail system.  This is only available if Voicemail is active for the operator. 
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Main Menu Bar 
• File:  

Changes to the Profile can be saved, Login with a different profile or exit the SoftConsole 
application. 

• View:  
Through the View menu it is possible to check which language is currently selected, change the 
display state of SoftConsole and control the Toolbar. 

• Actions:  
Specific functions used to handle calls. The menu items will only be enabled at the appropriate time. 
  

• Directory:  
Options to view the Directory Entry properties for a selected directory, search the call details panel, 
export the directory and amend setup details through the configuration form. 

• Tools:  
This menu gives access to Dial Pad,  Door Release, Send Email, View Conference Rooms, Call 
Voicemail and configure the application. 

• Help: 
Access to the help system and details about Avaya IP Office SoftConsole. 
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Call Details Panel 
The Call Details panel contains a side-by-side display of current call information.  A slider positioned 
between the two subpanels allows the operator to adjust the size of the panels as required. 

The panel on the left contains details about the current call. 

• Calling Name: The System Directory Name associated with the Calling Number.  If the Calling 
Number is "WITHHELD" then neither the Calling Number nor the Calling Name information is 
displayed.  If there is no association between the Calling Party Number and a Directory Name the 
Calling Name information is not displayed. 

• Calling Number: The telephone number of the Call Originator.  (The telephone number and 
associated name will be presented if available).  If the Calling Number is "Withheld" then neither the 
Calling Number nor the Calling Name information is displayed. 

• Called Name: The System User Name or Hunt Group Name associated with the Called Number. 

• Called Number: The extension number the incoming call has been routed to by the System. 

• Call Status: States the progress of a call.  The border around the Call Details Panel changes color 
to indicate the status of a call.  

Call Status Default Border Color 

Alerting - Incoming Red 

Alerting - Outgoing Red 

Connected Green 

Dialing Green 

Held Blue 

Returned Calls Yellow 

Idle Black 

• Call Duration: The length of time that the call has been in the state as indicated by the Call Status. 

• Notes: This area displays notes or information about the call i.e. when a call has been returned as 
there was no answer from the extension it was transferred to. If annotation is attached to the call, 
details are shown in the Notes area. 
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The panel on the right displays information about: 

• Directory entries.   

• Single Directory entry details 

• Details about a consultation call 

• A script file when a script file has been configured for either the calling or called number. For 
example, an operator may be answering calls on behalf of more than one company.  To ensure the 
call is answered with the correct company name a script file can be created with the company name 
details.  The script file is displayed whenever a call is received for that company. 

 

The toolbar in the panel allows the operator to: 

• Search Directory.  Enter a name or number.  When a directory entry 
match is found  the properties specific to the entry are displayed. 

• Call the selected directory entry . 

• View the directory properties for the selected entry.    

•  View Directory Items. 

•  View Active Conferences. 

•  Show/Hide User Entries. 

•  Show/Hide Group Entries. 

•  Show/Hide Directory Entries. 
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A double click on a Directory entry displays details of the entry. Double click again to view the Directory 
Properties. 

 

 

 

Directory Entry Forms 
The SoftConsole Directory Entry Properties forms allow the operator to examine details about the selected 
directory entry.  In some cases, the operator can edit the information and change the user's status.   The 
form displayed depends upon the directory entry type. 

• IP Office User - Directory Entry Properties Form. 

• Group Entries - Group Service Status Form. 

• Non IP Office user - External Directory Entry Properties. 
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Directory Entry Properties Form 
The properties of an IP Office user are shown in the Directory Entry Properties.   

• User Name: Cannot be changed. 

• Extension: Cannot be changed. 

• Full Name: Shows the user's full name. Cannot be changed. 

• Logged In: This check box indicates the user's logged in state.  The operator cannot change this 
option. 

• Do Not Disturb: Shows whether the user is in the Do Not Disturb state or not.  The operator can 
change the user's status. 

• Bar Outgoing Calls: This check box allows the operator to control whether the user can make 
outgoing calls. 

• Forwarding Button: Clicking on this button will open a dialog box that allows the operator to view or 
change the forwarding status of the directory entry.   

• Group Status: A list of the Hunt groups that the user belongs. If the group is checked then the user 
is 'in group'.  The operator can alter the group status of a group member i.e. from being 'in group' to 
'out of group' 
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Forwarding Status Form 
The form allows the operator to view and change the forwarding status of an extension. 

• Follow Me:Take calls from another extension. 

Destination: The extension to receive the calls. 
  

• Forward Unconditional: Forward all calls  
(To forward all Hunt Group calls select the option Forward Hunt Group Calls and enter the 
destination extension in this section). 

Destination: The extension to receive the  calls. 
  

• Forward on Busy: Forward calls when the phone is busy. 
Forward on No Answer: Forward calls when the extension is not answered. 

Destination: The extension to receive calls when the phone is busy or not answered. 
  

• Forward Hunt Group Calls: Forward all Hunt Group calls.  Select the option Forward Unconditional 
and enter the destination extension. 

 

Note: If the options Follow Me, Forward Unconditional or Forward on Busy are selected a destination 
extension number MUST be entered.  Changes cannot be saved unless a destination extension is entered.   
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External Directory Entry Form 
If the selected directory entry is not an IP Office user, then the External Directory Entry Properties form is 
shown.  No details can be changed by the operator. 

• Name: the name associated with the Phone Number. 

• Extension: the extension number for the user. 

• Phone Number: the phone number for the user. 

• Mobile Number: the mobile number for the user. 

• Fax Number: the fax number for the user. 

• Email Address: the Email address for the user. 

 

Group Service Status 
When the properties of a group is selected then the Group Service Status is shown.   

• Group Name: The name of the group who's properties are being viewed. 

• Service Status: A Group's Service status can be either In Service or Out of Service.  The operator 
can bring a group into service or take it out of service by clicking the corresponding button. 
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BLF Panel 
The Busy Lamp Field (BLF) Panel displays icons to indicate the status of selected users.  The BLF panel 
provides information on: 

• Unread 'User' Voicemail messages. 

The user has Unread Voicemail Messages if there is a yellow envelope in the left corner 
of the icon.  The number of messages appear in brackets after the BLF name, in this case there are 
2 unread messages. 
  

• The Extension/User status e.g. if the user is busy, calls are being forwarded, or Do Not Disturb is 
active. 
  

The user is Busy if there is a red circle with a white cross in the upper left corner of the icon. 
 

The user has Forward Unconditional active if there is a green circle with a white arrow in the 
upper right corner of the icon.  If the mouse cursor is positioned over the icon details of the forward 
destination will show. 
 

The user has Do Not Disturb active if there is a blue circle with a white cross in the lower 
right corner of the icon. 
  

If the cursor is placed over an icon the status information will show.  The details shown are the users 
name, extension number, status and the number of new messages.  If the user is not logged in then 
the status will show as Logged Out.  If the user is Logged In then the extension/user status will be 
shown e.g. idle. 
  

Icons can be displayed on separate tabs and used as a Speed Dial.  To use a BLF Icon as a Speed Dial: 

1. Right click the BLF Icon. 

2. Select the option Call. 
Or 

1. Highlight the BLF Icon. 

2. Press Ctrl+Alt+C 
Or 

1. Double click the BLF Icon. 
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BLF Panel Views 

 

To change the view 

• Right click in the BLF Panel and select View from the pop-up menu.  Select the view type required. 
Or 

• Use the Keyboard Codes as shown in brackets. 

• Large Icons (Ctrl+Alt+G) 

• Small Icons (Ctrl+Alt+S) 

• List Icons (Ctrl+Alt+I) 

• Details (Ctrl+Alt+D) 

 

To re-arrange the Icons: 

• Right click in the BLF Panel and select Arrange from the pop-up menu.  Select the way you want to 
arrange the icons. 
Or 

• Use the Keyboard Codes as shown in brackets. 

• Name Order (Ctrl+Alt+N) 

• Number Order (Ctrl+Alt+M) 

• Status Order (Ctrl+Alt+U) 

• Horizontally  (Ctrl+Alt+H) - Available in small icons or large icons view. 

• Vertically (Ctrl+Alt+V) - Available in small icons or large icons view. 

 

Members can be added to a BLF group by double clicking within the BLF panel.  New BLF groups can be 
created and BLF members can also be added through the BLF Configuration form. 
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Add Members to a BLF Group 
Members can be added to a BLF Group from the BLF Panel within the Main window. 

To add member from the Main window: 

1. View the BLF Group in which the members need to be added. 

2. Right click within the BLF Panel. 

3. Highlight New, click BLF Group Member.  The New BLF Member dialog box appears. 

4. Enter the User's Name and the extension number. 

5. Click OK to return to the BLF panel. 

 

Note: BLF Members can also be added by: 

• Click within the BLF Panel and press Ctrl+Alt+B to show the New BLF Member dialog box. Enter 
the members name and extension number.  Click OK to return to the BLF Panel 

• Double click within the BLF Panel to show the Edit BLF Group Properties dialog. Add members as 
required. Click OK to return to the BLF Panel. 

 

Views  
Any profile can view SoftConsole in either Compact View or Normal View. Compact View only contains 
Toolbars, Call Details and Queue Panels. To toggle between the views: 

• Click the Compact View button.  
Or 

• From the View menu click Compact View. 
Or 

• Press Home 
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Call Handling 
Incoming Call Handling 
When an incoming call is received the Call Details Panel is outlined in red and displays the information 
about the call.  If a script file is associated with incoming call number the script is shown in the right call 
panel.  

 

 

 

To answer the call. 

• Click the Answer Call button.  
Or 

• From the Actions menu, select Answer Call. 
Or 

• Press Enter.   
Or 

• Pick up the handset if using a conventional telephone. 
Or 

• Double click in the Call Details Panel. 

 

When a call is answered the caller information is shown in green. 

Enter the extension number or User Name the caller requires in the Call Details directory panel. 
SoftConsole will search for a match.  Once a valid entry is identified details appear on the screen. 

Note If a script is shown click on the Close Script button or press Enter.  The Search Directory field will 
become available. 

 



Page 16 

Page 16 SoftConsole Users Guide 
40DHB0002USEJ Issue 1 (23rd September 2003) IP Office 

To transfer the incoming caller to an extension: 

• Click the Transfer Call button.  
Or 

• From the Actions menu, select Transfer Call 
Or 

• Press F2 for an immediate transfer (Unsupervised Transfer)  
Or 

• Press F12 to talk the user before completing the transfer (Supervised transfer). 
Or 

• Drag and drop the call information onto the directory entry.  (Click on any call information details in 
the left pane and drag to a directory entry in the right pane). 

If the extension is busy the call can be put on hold against the extension number by pressing Ctrl+B. The 
caller is on hold against the extension for 15 seconds or until the destination extension becomes free.  The 
call is automatically presented back to the operator indicating why it has been returned i.e. timeout or that 
the extension is free.  

Note: The hold time against an extension is controlled by the telephone system.  Consult your System 
Administrator for details on how to configure this option. 

 

Transfer a call without answering. 

If the operator recognizes a calling name or number it is possible to transfer the incoming call without 
answering it. 

To transfer a call without answering 

1. Enter the destination extension number in the Search field. 

2. Transfer the call as described in the previous section. 
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Scripts 
A script can be associated with an incoming calling number or an outgoing called number.  The script gives 
the operator information relevant to the calling number e.g. the company name and specific instructions. 
 When an operator handles calls for more than one company the ability to answer incoming calls with the 
correct company name is essential. The use of a script will help the operator to do this. 

A script is text saved as a .TXT or .RTF file and associated with the incoming calling number from the 
Incoming Call Handling configuration form. 

 

Reclaim Calls 
If a call is transferred to the incorrect internal extension,  user's Voicemail, Park Slot or placed the call on 
Hold, the Reclaim Call command can be used to return the call to SoftConsole.   

To reclaim the last call handled  

• From the Actions menu select Reclaim Call 
Or 

• Press F6. 
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Transfer a Call (Unsupervised) 
A call can be transferred to a user without the call being verbally accepted first.  Enter the extension number 
or user name in the search section of the Directory Panel.  Details of the single directory entry are shown.  If 
the extension is indicated as free transfer the call by: 

• Click the Transfer Call Button.  
Or 

• From the Actions Menu select Transfer Call. 
Or 

• Press F2 
Or 

• Drag & drop the call onto the extension within the Directory panel 
Or 

• Drag & drop the call onto the required BLF. 

 

The incoming call is immediately transferred to the destination extension and cleared from the screen. 

If the call is not answered and Voicemail is turned on the call is transferred to user's Voicemail.  If Voicemail 
is not turned on the call rings the transfer number until answered.   

Note: The SoftConsole operator be can configured to have unanswered calls returned to the SoftConsole. 
 Consult your System Administrator for details on how to configure this option.  When a call is returned, 
(NoAns) is shown in the Current Call Information box.  The SoftConsole operator can answer the call and 
reattempt the transfer, transfer the call to the user's Voicemail or select another transfer number. 
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Transfer a Call (Supervised) 
When the operator needs to consult a user to verify that they are free to currently accept a call,  a 
consultation call is needed.  During a supervised transfer the original call information is shown on the left 
side of the call details area with a blue border. The consultation call details are shown on the right side of 
the call details area with a green border.   

 

 

To make a Consultation Call 
1. Enter the extension number or User Name in the search field of the Call Details Directory Panel and 

check if the destination extension is free.  

2. If the extension is free make a call to the extension by one of the following methods. 

• Click the New Call button.  Or 

• From the Actions menu select New Call.  Or  

• Pressing F12.  
The progress of the outgoing call can be heard. 

3. Once the call is answered and the incoming call verbally accepted then connect the caller by one of 
the following methods. 

• Click the Transfer Complete button.  Or 

• From the Actions menu select Transfer Complete.  Or 

• Press Ctrl+T. 

4. If however the user cannot receive the incoming call at this time finish the consultation call by one of 
the following methods. 

• Click the Hang Up button.  Or 

• From the Actions menu select Hang Up.  Or 

• Press End. 

Note: When making a consultation call press Ctrl+A to toggle between the two calls. 
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Transfer a call to Voicemail 
If an incoming caller wants to leave a message for a user then the caller can be directly transferred to the 
user's Voicemail.   

To transfer a call to Voicemail: 

• From the Actions menu select Voicemail Transfer. 
Enter the extension number into the Transfer to Voicemail dialog box. 
Click OK. 
Or 

• Press F3  
Enter the extension number into the Transfer to Voicemail dialog box.  
Click OK. 
Or 

• Locate the extension number in the directory panel. 
Press F3 to transfer the caller to Voicemail. 
  

Making an outgoing call 
To make a call 

1. Enter the internal or external number or User Name in the Call Details Search field 

2. Click the New Call button . 
Or 
From the Actions menu select New Call. 
Or 

Press F12. 

The Current Call Information area shows details of the outgoing call.   
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Using Hold 
All calls that the operator places on hold can only be retrieved by the operator. There are three types of 
hold: 

• Hold.  

• Hold call against extension number. 

• Hold call and auto-answer next alerting call. 

 

To place a call on hold. 

• Click the Hold button . 
Or 

• From the Actions menu select Hold Call. 
Or 

• Press F4. 

The call is put on hold and shown in the Held Calls Panel.  The time a call is held in the Held Calls Panel is 
controlled by the telephone system.  Consult your System Administrator for details on how to configure this 
option. 

Note: If the operator hangs up on a call while there is a call on hold, the operator will automatically be 
connected to the call. 
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Held Calls Panel 
The Held Call Panel contains a list of all held calls at the operators station.  All calls are shown in a listing 
detailing the following information: 

• Calling Party Information. 

• Called Party Information. 

• The amount of time the call is on hold. 

• The Call Annotation for the call, if applicable. 

The operator can sort the list by clicking the corresponding column header.  Clicking a row in the list selects 
the call so the operator can answer or transfer the call.  

The toolbar at the top of the panel allows the following actions. 

Answer the Selected Held Call: Any held call can be answered when the call is in the Held Calls 
Panel. Select the relevant call and then click this button. 

Answer Longest Held Call: Answers the call that has been on hold for the longest time. 

Conference with Held Calls: Creates a conference with the current call and all calls on hold. 

Transfer Held Call: Transfers a selected held call (unsupervised transfer) 

 

Note: Right click in the Held Calls panel causes a pop-up menu to be displayed.  It offers the same options 
as the toolbar buttons. 
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Hold against a busy extension 
If an extension is busy a call can be placed on hold against the busy extension number by pressing Ctrl+B. 
 The caller is put on hold until timeout happens, or until the destination extension becomes free.  The call is 
automatically presented back to the operator indicating why it is being returned i.e. timeout or that the 
extension is free.  The operator can reattempt the transfer or answer the call. 

Note: The hold time against an extension is 45 seconds. 

 

Hold Current Call and Auto Answer Next Call 
To place the current call on hold and automatically answer another call that arrives within one second press 
F7.  If an operator is a member of a queue which is getting congested, then the operator can use this 
feature to reassure callers that their calls will be handled shortly, . 

 

Reattempt Transfer 
The reattempt transfer action is used to retransfer a returned call to the original transfer extension. The call 
details panel has a yellow border when a call is returned.   

A call can be retransferred when: 

• A call was held against a busy extension.  The extension becomes free so the call is returned to the 
operator.   

• A call was transferred to a free extension.  The call is returned to the operator as the call was not 
answered and Voicemail was not available. 

 

To reattempt a transfer: 

• Click the Reattempt Transfer button . 
Or 

• From the Action menu select Reattempt Transfer. 
Or 

• Press Ctrl+R. 

 

If this feature is not available refer to the section on trouble shooting. 
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Parking a Call 
It is sometimes necessary to temporarily "park" a call to handle some other tasks (receive a new call) or deal 
with an interruption.  An example of Parking is where an incoming caller needs to speak to someone 
urgently but they cannot be found.  The call can be parked in slot "1", and the specific user paged to pick up 
the call on "1".  Calls will remain parked for a specific length of time before being returned to the operator. 
Consult your System Administrator for details on how to configure this option. 

SoftConsole provides parking slots for 16 calls, all with specific Park ID.  When a call is parked in one of the 
park slots, the button label provides information about the call.  When a park slot is vacant, the button label 
shows the park slot ID.  All operators can see when the call is picked up or ended. Calls parked by the 
operator can be collected by anyone.  

• To park a call: 
When the call is active in the Current Call Information panel, click a vacant Park Slot within the Park 
Slot panel to park the call. The parked call is highlighted in red and displays information regarding 
the call e.g. the source number of call. 

• To Unpark a Call: 
When a call is parked in a Park Slot, click the relevant Park Slot Button to unpark the call. 

If a secure a parking slot is required for private use, configure the Park ID with text so a call cannot be 
unparked using a short code. 
  

Default Short Cut Codes used to Park or Unpark a call. 

Park / Unpark Call in Park Slot 1 Alt+F1 

Park / Unpark Call in Park Slot 2 Alt+F2 

Park / Unpark Call in Park Slot 3 Alt+F3 

Park / Unpark Call in Park Slot 4 Alt+F4 

Park / Unpark Call in Park Slot 5 Alt+F5 

Park / Unpark Call in Park Slot 6 Alt+F6 

Park / Unpark Call in Park Slot 7 Alt+F7 

Park / Unpark Call in Park Slot 8 Alt+F8 

Park / Unpark Call in Park Slot 9 Alt+F9 

Park / Unpark Call in Park Slot 10 Alt+F10 

Park / Unpark Call in Park Slot 11 Alt+F11 

Park / Unpark Call in Park Slot 12 Alt+F12 

Park / Unpark Call in Park Slot 13 Shift+F9 

Park / Unpark Call in Park Slot 14 Shift+F10 

Park / Unpark Call in Park Slot 15 Shift+F11 

Park / Unpark Call in Park Slot 16 Shift+F12 
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Collect a parked call 
When an operator parks a call the call can be collected by anyone. An example of Parking is where a user 
has to be paged to make a call.  An incoming caller needs to speak to someone urgently but they cannot be 
found.  The call can be parked in slot "1", and the specific user paged to pick up the call on "1".  The user 
can pick up the call from any phone using a short code, e.g. *38*1# (1 being the slot number). 

To pick up a parked call from an IP Office telephone. 

• Dial a default short code, e.g. *38*N# (N representing the Park ID). 

Or 

To pick up a parked call through Phone Manager.  

• Park Slots with the same ID as the Park Slots within SoftConsole will show parked  calls. 
 The Caller information will be displayed if it is available 

Or 

A telephone with DSS Keys can be programmed with a Park Slot Number against a key.  The DSS 
key can then be used to pickup and park calls.  See your System Administrator for more information. 
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Working with Queues 
Calls to a Hunt Group are held in a queue when all available members of the hunt group are busy. You can 
be a member of a Hunt Group, for example "Main", and automatically be presented with calls to this group. 
 The name of the Hunt Group is displayed in the Calling Name field in the Call Details, Current Call 
Information Panel.  You can also monitor the number of calls being held in a queue for a particular Hunt 
Group. For details on creating, modifying and deleting a Queue refer to the section called Configuring a 
queue. 

 

Monitor a Queue 
The Queue Mode Panel displays up to eight Queues.  They indicate the number of calls currently queued 
for a specific Hunt Group.   

The number of calls held in a queue is indicated by a bar graph with the total number of calls shown at the 
end of the bar graph.  Each call is displayed as a white box if the alarm threshold has not been exceeded.  If 
the number of calls in the queue exceeds the alarm threshold then the calls exceeding the threshold are 
displayed as an amber box. 

The longest length of time a call has been in the queue is indicated in the text box at the end of the graph. 
 The time is updated whenever a call is queued. The time will be displayed in white if the longest wait time 
alarm threshold has not been exceeded.  The time will change to being amber if the longest wait time is 
exceeded. 

When the mouse pointer is moved over an active Queue Call bar the Queue Name, number of calls in the 
queue, number of Recall calls and the queue status (normal or alarmed) is displayed.  

 

 

 

Answer a Queued Call 
If you are a member of a Hunt Group a queued call is automatically presented in the Current Call 
Information panel. The name of the Hunt Group is displayed in the Calling Name field.  You can answer the 
call in the normal way. 

If you are not a member of a Hunt group you are able to answer queued calls.  To answer a call click on the 
Queue name button, the first call in the queue is presented to the operator with the Hunt Group name 
displayed in the Calling Name field.  Answer the call in the normal way. 
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Conference Calls 
Within SoftConsole calls can be conferenced when held or a conference can be created through the two 
conference rooms. 

 

Conference Held Calls. 
An operator can conference calls that are in the Held Panel.  All calls in the Held Panel will be conferenced. 

1. Place all the user's to be conferenced on hold. 

2. To conference all the calls on hold press the Conference with Held Calls button.  

3. To remove the operator from the conference call, click the Hang Up Call button.  

Note:   New users can be added to the conference by selecting Add to Conference from the Action menu. 
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Conference Room  
The Main Toolbar contains two buttons that represent the two conferences rooms.  For the Conference 
buttons to be available the conference room names need to have been set up. 

To create a conference: 

1. Click either Conference Room 1  or Conference Room 2 .  A conference window will 
appear.  The name of the conference room will appear on the tab e.g. Conference Room 1 / Alpha. 
If the conference room is not currently in use the window will be blank. If in use then the current 
members of the conference will be shown. 

2. In the Conference Description area type the subject of the conference. This will only show on the 
conference room form and is optional. 

3. In the Conference Host area type the name of the person who has requested the conference. This 
will be shown in the View conferences area of the directory panel. 

4. Enter the users for the conference by: 

• Click the Add Users button and select users from the Directory list. 

Or 

• Drag and drop BLFs from the BLF Panel into the window. 

Note: if a user is added by mistake they can be deleted by right click on the BLF, select the option 
Remove. 

5. If Voicemail Pro is present users can be invited  by clicking on the Invite button. The BLF icons will 
show with a blue outline and each delegate will be automatically invited to the conference.  When the 
delegates phone rings they are invited to join the conference by pressing 1, decline the invitation by 
pressing 2 or that they are unavailable by pressing 3. The BLF's will change automatically to indicate 
the status of the call. 
Or 
If Voicemail Pro is not present invite the users manually.  Double click a delegates icon  to call the 
user and invite them to the conference.  

• If they accept click on either Add to conference room 1 or Add to conference room 2 from 
the Actions menu.  

• If the user is unavailable or has declined the invitation, right click on the BLF and change the 
status accordingly to record the delegates response. 

The invited delegates status is represented by an icon in the Conference Room window.   

Not Invited.  Invited. Joined. Declined. Unavailable 
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Once a conference is in progress new delegates can be manually invited into the conference by: 

• The operator calls the delegate and adds them to the conference using the Add to conference 
action. 

• Calls to the operator can be added to the conference by using the Add to conference action. 

 

To change the view: 

• Right click in the Conference Room Window and select View from the pop-up menu.  Select the view 
type required. 

• Large Icons 

• Small Icons  

• List Icons 

• Details 

 

To rearrange the Icons: 

• Right click in the Conference Room Window and select Arrange from the pop-up menu.  Select the 
way to arrange the icons. 

• Name order 

• Number order 

• Status order. 

 

To change the status of a delegate: 

• Right click on the Icon 

• Select Change Status 

• Select the status i.e. Not invited, Invited, Joined, Declined, or Unavailable. 

 

Note: To view all active conferences, including conferences created by Power Conferencing  click  
within the Call Details Directory panel. 
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Features 
The Actions menu contains commands for: 

• Reclaim Call: Return the last handled call to SoftConsole. 

• Alternate Calls: Toggle between a consultation call and original incoming call. 

• Answer Call: Answer the incoming call. 

• Annotate: Associate a text annotation with a call. 

• New Call: Start a new call. 

• Conference: Conference the current call with all calls that are on hold.  

• Hang up: Disconnect from the current call. 

• Hold: Place the current call on hold. 

• Hold Call and Auto-Answer Next Alerting Call: Place the current call on hold and if another call 
alerts the operator's station within one second, then that call is automatically answered. 

• Hold Against: Place the current call on hold against a specific extension number. 

• Intrude: Intrude upon a user who is active on a call. 

• Page: Activate the paging feature. 

• Record Call: Turns on call recording. 

• Send Message: Allows the operator to send a message to a user that is visible either on the user's 
telephone display or through phone manager. 

• Transfer Call:  Transfer the current call. 

• Transfer Complete: Complete a supervised transfer. 

• Reattempt Transfer: Transfer a call that is returned to the operator 

• Voicemail Transfer: Transfer a call to a user's Voicemail. 

• Add to Conference: Transfer a call into a Held calls conference 

• Add to Conference Room 1: Add a call to Conference room 1. 

• Add to Conference Room 2: Add a call to Conference room 2. 

• Pick Queue: Pick up a call from a Queue. 

• Park: Park  a call. Lists the available park slots. 

• Unpark: Retrieve a parked call. Lists the park slots containing a parked call. 
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The Tools Menu contains commands for: 

• Dial Pad: Show the pop up Dial Pad form. 

• Door Release: Open controlled doors without leaving the desk. 

• Send Email: Send a message to a user via the email system. 

• Call Voicemail: Connect to the Voicemail for the user that is logged into SoftConsole. 

• Conference Room: Enter a conference room 
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Annotate  
Text can be associated with a call.  This feature is also known as 'Tagging' a call. Alpha & Numeric 
characters can be used but not commas.  By default the length of a message is up to 16 characters.  The 
Administrator can specify the maximum length of call notes. 

To Annotate a call: 

• From the Actions menu select Annotate Call 
Or  
Press F11  

• Type the required details and click OK. 

The Current Call Information panel shows with a notes field containing the text that was entered. When the 
call is transferred the message is displayed at the extension if the equipment can display text. 

Note: The annotation is also shown on the originator's phone if the equipment is capable of displaying text 
and the call is internal. 

 

Intrude 
This is only available if the operator has permission to intrude and the other internal parties have given 
permission to allow intrude to happen.  Consult your System Administrator for details on how to configure 
this option. 

To intrude upon a user who is active on a call: 

1. Locate the user in the directory panel. 

2. From the Actions menu select Intrude. 
Or 
Press F9. 

3. Speak to the User. 

4. When finished press the Hang Up button.  
Or 
From the Actions menu select Hang Up 
Or 
Press the End button. 
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Page 
The SoftConsole operator can broadcast a message to a specific group of people.  For example, an 
incoming caller needs to speak to someone urgently but they cannot be found.  The call can be parked and 
then a message broadcast for the user to pick up the call. 

To broadcast a message: 

1. Click the Page button.  
Or 
From the Actions menu select Page. 
Or 
Press F10 

2. Select the group to broadcast to and click OK. 

3. Speak the message 

4. To end the Page click the Hang Up button.  
Or 
From the Actions menu select Hang Up 
Or 
Press the End button. 
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Record Call 
• Refer to your local regulations in relation to recording calls.   

If Advice of Call Recording (AOCR) is required, speak to your system administrator. 

Current calls can be recorded, either a complete call or just part of the call.  Recordings will stop when a call 
is put on Hold or is disconnected.  When Conference calls are being recorded the recording will be stopped 
when another caller is added to the conference. 

 

To record the current call conversation: 

• Click the Record Call button  
Or  

• From the Actions menu select Record Call 
Or 

• Press F5  
The conversation is recorded into the operators own voice mailbox.   

 

To finish recording  

• click the Record Call Button  
Or 

• From the Actions menu select Record Call 
Or 

• Press F5 

 

Note: Recordings are only supported when VoiceMail Pro is installed.   
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Send Message 
This option allows the operator to send a message to a user.  The message is visible either on the user's 
telephone display or through Phone Manager Pro. Messages can be received whilst the user is on a call.   

To send a message: 

1. Locate the user in the directory. 

2. From the Action menu select Send Message. 
Or 
Press Ctrl+M  
The user's extension number field will automatically be completed from information showing in the 
directory. 

3. Enter the message and press OK. 

If this feature is not available refer to the section on trouble shooting. 

Note  By default the maximum length of a message is 16 characters.  The length is controlled by the call 
note size. 

 

Reattempt Transfer 
The reattempt transfer action is used to retransfer a returned call to the original transfer extension. The call 
details panel has a yellow border when a call is returned.   

A call can be retransferred when: 

• A call was held against a busy extension.  The extension becomes free so the call is returned to the 
operator.   

• A call was transferred to a free extension.  The call is returned to the operator as the call was not 
answered and Voicemail was not available. 

To reattempt a transfer: 

• Click the Reattempt Transfer button . 
Or 

• From the Action menu select Reattempt Transfer. 
Or 

• Press Ctrl+R. 

 

If this feature is not available refer to the section on trouble shooting. 
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Using Dial Pad 
The operator can use the Dial Pad to dial a phone number from the application. 

To start Dial Pad: 

• Click the Dial Pad Button . 
Or 

• From the Tools menu select Dial Pad. 
Or 

• Press Shift+Ctrl+F3. 

 

 

 

The required telephone number can be entered into the 'Number to Dial' field by using the dial characters on 
the Dial Pad or from the keyboard.  Notes for the call can be entered in the Call Notes area.  

 

When completed click the Dial button to start the call. 
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Door Release 
The Door Release allows the SoftConsole operator to open controlled doors, without leaving the desk.  Two 
doors can be controlled by the SoftConsole operator.  The doors will be released for 15 seconds by default. 
  

To open a door using SoftConsole: 

1. From the Tools menu select Door Release.  

2. Click the required door name to release the door. 
Note: Before the option Door Release is available to the SoftConsole Operator, the doors need to be 
configured. 

 

Configuration 
1. From the Tools menu select Options and click Door Entry 

2. Enter a name for Door 1.  The name entered is shown when the option Door Release is selected. 
 Access to the Entry Code field is prevented as the Entry Code for door one is set to 1. 

3. Enter a name for Door 2 if required. 

4. Click OK. 

 

Send Email 
The SoftConsole operator can send a message to a user via Microsoft Outlook. 

To send an email message: 

1. From the Tools menu select Send Email.  
Or 
Press Ctrl+E. 

The email message form will appear.  Complete the details as required and send in the usual way. 
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Administration 
Login Form 

 

 

When the Login form has been completed click the OK button.  The Login screen will continue to be 
displayed until the operator has successfully logged in.  During this time the message "Login in progress, 
please wait...." is displayed at the bottom of the screen.  If the Login fails the message "Login unsuccessful. 
 Please try again" is shown. There are several reasons why a Login attempt may fail. 

• The incorrect IP Office IP Address 

• An invalid user name and/or password has been entered 

• There may be network problems 

• The operator is not logged into the telephone. 

 



Page 40 

Page 40 SoftConsole Users Guide 
40DHB0002USEJ Issue 1 (23rd September 2003) IP Office 

The form needs to be completed with the following information. 

• Profile 
A drop down list of the available profiles.  The chosen profile is the default profile the next time 
SoftConsole is started.   

• Show Templates 
Indicates whether templates are included in the Profile drop down menu. To view both Templates 
and Profiles in the drop down list select this option.  The list includes predefined templates.   

• IP Office IP Address 
The IP Address of the IP Office system.  Click the Browse button to select another IP Office system. 

• User Name 
The user name that is used to log in to the IP Office system  

• Password 
The password associated with the user name.  Each character of the password is displayed as an 
asterisk (*) 

• Call Waiting 
The Call Waiting feature provides a Call Waiting Tone when the operator is on a call and another call 
is presented. When the existing call is dropped the new call is immediately presented to the 
operator. 

• Off-hook Station 
If selected the Off-hook Station feature is turned on for the operator during the current session.  This 
feature is typically used by operators using the hands free features of the telephone. SoftConsole will 
control the operation of the telephone. 

 

 

IP Office Control Units 
If there is more than one IP Office system available the operator can select the unit to be connected. A 
listing shows the Unit name, IP Address and version.  

To select a Unit: 

1. Highlight the unit in the list 

2. Click OK. 

If the required IP Office system is not listed contact your System Administrator. 
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Administrator Functionality 
When in Administrator mode the operator can: 

• Change and create templates. There are predefined templates supplied. New templates can also be 
created. 

1. Select a predefined template at the Login screen. 

2. Login as Administrator 

3. Make changes as required. 

4. Save the new template from the File menu, Save Template as option. 

5. Enter a name for the template and click OK. 

• Control which panels are viewed.  From the View menu you are able to display or remove the 
following panels. 

• BLF Panel. 

• Held Calls Panel. 

• Park Slots Panel. 

• Change the Administrator password. We recommended that the user name Administrator is not left 
with the default password.  

• Edit the profile of other users. 

1. Select the user's profile to edit 

2. Login as Administrator. 

3. Make changes as required 

4. Save the profile from the File menu, Save Profile option. 

• Specify the maximum length of Call Notes. 

Note: When logged in as an Administrator there is no access to the telephony functions. 

 

To Login as Administrator with the default settings: 

1. At the Login screen enter: 
User name: Administrator  
Password: password (case sensitive) 
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Change Administrator Password 
When the application is first installed the password for Administrator is password.  It is advisable to change 
the password once the application is installed. 

To change the password for the first time: 

1. Login as: 

User name: Administrator  
Password: password (case sensitive) 

1. From the File menu select Change Administrator Password. 

2. Enter the old Password (password) which will show as asterisks. 

3. Enter the new password.  Make a note of the new password being careful regarding capitalization as 
the password is case sensitive. The password will appear as asterisks. 

4. Enter the new password again to confirm and click OK. 
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Configuration Form 
The SoftConsole Configuration Form allows the operator to configure the application and to set individual 
preferences.  The configuration options are divided into sections on a series of tabbed pages. 

• Incoming Calls 

• Queue Mode 

• Park Slots 

• BLF Groups 

• Door Entry 

• Directories 

• Conferencing 

• Keyboard Mapping 

• Keyboard Actions 

• Appearance  

• Save 

 

To view the configuration screen: 

 

1. From the Tools Menu select Options. 

2. Select the configuration group to amend. 
 
Or 

1. Click the Configure SoftConsole Options button.   
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Incoming Calls Configuration 
The IP Office SoftConsole Local Directory  shows details of external numbers and the associated name. 
 For example, if a lot of calls are received from a certain calling number the details can be entered into the 
Local Directory. Whenever a call is received from the specified number, the call information will show the 
name associated with the number.  You can also associate specific script & media files against a calling 
name or number. 

The list shows the SoftConsole Local Directory entries.  It contains four columns: 

• Name - The name associated with the number. 

• Number - The telephone number (or short code) that is dialed when the Directory Entry is selected. 

• Script File - The path to the txt/rtf file to be displayed when a call is made to the number entered in 
the Number field. 

• Media File - The path to the .WAV, .AVI, etc. file that is played when a call is received from the 
number entered.   

 

From this form the operator can: 

• New: Add new details 

• Edit Change details for existing entries. 

• Delete: Entries can be removed by selecting the entry then click the Delete button. 

• Open Directory File: Choose the directory to be used. To open a different directory click the Open 
Directory File button.  By default the directory files are stored within a folder called Data in the 
SoftConsole Folder as .CSV files.  Select the required directory and click the Open button.   

 

Default call handling allows the operator to specify what actions happen when either a call presented or a 
number being called is not associated with an entry in the Local Directory.  If a Script file or Media file is 
required, click the relevant Browse button to find and select the file.  The file name appears in the 
corresponding field. 
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Local Directory List 
From the Incoming Calls tab you can create new entries and edit the properties of an existing entry. 

 

Create a New Entry. 
Click the New button within the Incoming Calls form.  The New IP Office SoftConsole Local Directory Entry 
form will show. 

• Name: 
The Name that you wish to be associated with the Directory Entry. 

• Number: 
The telephone number that will be dialed when the Directory entry is selected. 

• Script File: 
The name of a text file (.txt or .rtf) to be displayed when a call is presented to the operator with the 
number entered in the Number field. 

• Browse for Script File: 
Use the Browse button to find and select a script file on your PC or network. 

• Media File: 
The name of the .WAV files to be played when a call is presented to the operator. 

• Browse for Media File: 
Use the Browse button to find and select a .WAV file on your PC or network. 

 

Edit an Existing Entry 
Select the entry to be changed and then click on the Edit button within the Incoming Calls form.  The Edit IP 
Office SoftConsole Local Directory Entry form will appear.  The form is populated with the existing details. 
 Amend any of the details and then click OK to save the changes.  For information on the specific fields 
within the form, see the section Create a New Entry. 
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Configuring a Queue. 
A queue monitor can be configured for a specific Hunt Group.  The Hunt Group needs to be created on the 
System with Queuing enabled. Refer to your System Administrator for more details.  

SoftConsole provides you with the ability to configure and monitor up to eight queues.  One of the Queues is 
configured as a Recall Queue. 

To configure a queue: 

• Click the SoftConsole Options button then view the Queue Mode tab. 
Or 

• From the Tools menu select Options, then view the Queue Mode tab. 

The list of Queues contains: 

• Name: Name of the Hunt Group 

• Number: Extension number assigned to the Hunt Group 

• Alarm Thresholds: Shows the alarm settings for the number of calls in the queue and the 
longest waiting time alarm setting. 

• Short Cut: The keyboard code used to answer calls from the Hunt Group. 

The buttons allow you to:  

• Create a new queue: Click this button to add a queue to the list. 

• Edit an existing queue: Click this button to edit the properties of the selected queue. 

• Delete a queue: Click this button to delete the selected queue. 

• Move Up: Moves the selected queue up one position in the list. 

• Move Down: Moves the selected queue down one position in the list. 

Color Preferences:  

By default any queued calls which are under the alarm thresholds are shown as a white box in the Bar 
Graph.  Calls that are above the alarm threshold are in orange.  In this area you can select your color 
preferences for Normal and Alarm conditions. Any changes made to the conditions are applied to all the 
queues. 
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Alarm Handling 

This section allows the operator to specify how SoftConsole will behave if an alarm condition occurs whilst 
the application is minimized. 

• Automatically Restore: The SoftConsole application will pop up automatically if an alarm 
condition occurs. 

• Prompt: The SoftConsole application will display a dialog box that allows the operator to 
either maximize the application, or ignore the alarm condition. 

• Ignore: The SoftConsole application will ignore alarm conditions that occur while the 
application is minimized. 

 

Recall Queue 
A Recall Queue will show calls that have been queued, answered and then transferred, but the call has not 
been answered.  Instead of the call being returned to the end of the original queue the call is placed into a 
new queue called Recall.   

 

New/Edit Queue 
When you select to Edit or Create from the Queue Configuration tab, the Queue Properties dialog will show. 
 If you have selected an existing queue the details of the queue are entered in the form. 

• Queue Name: A drop down list of available Queues.  Select the Queue required. 

• Shortcut: Select the shortcut key combination required for the new queue. 

• Alarm Settings 

• Number of Calls in Queue: This option can be turned on or off.  This alarm occurs when the 
number of calls within a queue reaches the number specified in the Calls box.  

• Calls: The number of calls within a queue before an alarm occurs. 

• Longest Waiting Time: This option can be turned on or off.  If on an alarm will occur when 
the call wait time reaches the time specified in the Seconds box. 

• Seconds: The number of seconds a call waits within the queue before an alarm occurs. 

• Play Media File: When an alarm state is reached a specific sound can occur as an alarm.  If 
a media file is to be associated with an alarm, click on the Browse for Media File button and 
locate the file. 

When all the details are entered, click the OK button to save them. 
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Park Slots Configuration 
The Park Slots tab allows the operator to select which Park Slots are accessible through the SoftConsole 
application.  Each Park Slot has a unique ID. These IDs are system wide and available to everyone on the 
system.  This is very useful if you need to park a call that anyone can pick up.   

The form contains a list of the configured park slots shown in two columns, Park Slot ID and Short cut. The 
Park Slots can be configured using the buttons: 

• New  
Clicking this button opens a dialog box that allows the operator to add a park slot to the list.  There 
are a maximum of 16 slots available.    

• Edit 
Allows the operator to change the settings for the selected park slot i.e. change the assigned short 
cut key. 

• Delete 
Remove the selected park slot from the list 

• Move Up / Move Down 
The order of the configured park slots can be changed by moving the selected park slot up or down 
one position in the list. 
  

Note: Performing a right click on the Park Slot List View causes a pop up menu to be displayed.  The menu 
contains the same options as those accessible by the buttons on the form. 

. 

New/Edit Park Slot 
The New Park Slot / Edit Park Slot form allows the operator to add a Park Slot to the list of monitored park 
slots, or to edit the short cut assigned to an existing Park Slot.  Each Park Slot has an unique ID.  By default 
these are 1-16.   

• Park Slot ID: Each ID can be alphanumeric (contain letters and numbers) but only numeric ID's can 
be accessed via a Short Code.  Therefore the use of alpha characters secures the Parking slot from 
being picked up from a normal phone. The entered name may not include spaces. 

• Short Cut: A keyboard Short Cut which enables the operator to park or unpark a call into a specific 
Park Slot. 
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BLF Groups Configuration 
Busy Lamp Field (BLF) provides Extension/User Status Information at a glance, color coded for ease of use. 
 By creating groups (for example by department or location) you can logically view the status of a group. 

The buttons on the BLF Groups configuration form allow the operator to create or edit a BLF Group  

 

Create a New BLF Group 
From the BLF Groups Configuration tab click the New button. A dialog box appears. 

To create a BLF group: 

1. Enter a unique BLF Group name  

2. Select the required member from the 'Members not in BLF Group' list, then click the Add button. 
 The details show in the 'BLF Group Members' list on the right side of the dialog box.  

• Note: To add more than one member at a time, hold down the Ctrl key and click on each 
member.  When all members are selected, click the add button. 

3. When all members for a group are added, click the OK button to return to the BLF Groups 
configuration form. The new BLF Group is added to the end of the list. 

• The BLF tab sheets in the BLF Panel on the Main Form are presented in the same order that 
the BLF Groups appear in the list.  To reorder the BLF Groups, select a BLF Group and click 
the Move Up or Move Down buttons to move the group up or down one position in the list. 

4. Click OK to return to the Main Window. 

Note: To edit a group from the main screen, right click in a blank area of the BLF Panel to display a pop-up 
menu.  Select New, then click BLF Group to view the New BLF Group dialog box. 

 

Edit a BLF Group 
From the BLF Groups Configuration tab select the BLF group to be changed, then click the Edit button. An 
Edit BLF Properties dialog box shows.  Remove or Add members as required and then click the OK button 
to return to the BLF Groups configuration screen.  Click OK to return to the Main window. 

Note: To edit a group from the main screen, right click on a BLF Group and select properties from the pop-
up menu to view the configuration form for the selected BLF Group. 
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Directories Configuration 
This form is split into two sections.   

• Directory Access: Allows you to select which directories you have available. 

• Display Fields for Search Results: Allows you to select the details you want to include in Directory 
Entry Details. 

 

Directory Access 

• IP Office SoftConsole Local Directory 
If selected there is access to SoftConsole Local Directory as setup on the Incoming Calls tab. 

• IP Office Directory 
If selected SoftConsole provides access to the directory entries maintained by the IP Office switch. 

• Microsoft Outlook Contacts Folder 
If selected SoftConsole provides access to the Microsoft Outlook Contacts list.  This option is only 
available if Microsoft Outlook is installed. An Outlook icon shows in the directory list with the phone 
number. 

Note:  If directory access to Microsoft Outlook contacts folder is selected a Microsoft Outlook warning 
screen might appear.  If the warning screen appears: 

1. Select the Allow access for checkbox, and then click an amount of time in the list. 

2. Click Yes. Yes should always be selected to allow SoftConsole to retrieve Outlook contacts. 

 

Display Fields for Search Results 

The check boxes allow the operator to control which directory fields are included in the Directory Entry 
Details for a directory entry.  If the option is select then the details are shown in the search results.   
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• Name: This check box is always selected and cannot be changed. 

• Extension: This check box is always selected and cannot be changed. 

• Busy Status: Busy or Idle. 

• Do Not Disturb Status  Off or On. 

• Forwarding Status: When selected the status of the types of forwarding are shown. e.g. Forward 
Unconditional, Forward on No Answer, Forward on Busy, Follow Me, and Forward Hunt Group Calls.  

• Forwarding Destination: Only available if Forwarding Status selected. When selected the extension 
number that will receive the forwarded calls shows. 

• Forwarding Destination Status. Only available if Forwarding Status selected. The status of the 
extension number receiving the calls. 

• Login Status. Logged In or Logged Out. 

• Group Status. When this check box is selected the groups that the extension belongs in will show 
either In Group or Out of Group. 

• Absent Message.  The message will be displayed if set in Phone Manager. 

• New Voicemail Message.  Indicates the number of unread messages against the extension 
number. 

• Phone Number. 

 

The following search results are only available when looking at the properties of Outlook extension 
numbers. 

• Mobile Number. 

• Fax Number. 

• Email Address. 
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Conferencing Configuration 

Click the button and view the Conferencing tab. This option allows the operator to set up the names of 
the two conference rooms.  The name will appear on the telephone displays of users in the conference 
room.  The names can contain up to 10 characters and must be unique. 

 

Keyboard Mapping Configuration 
All short cut keys can be changed. 

1. From the Tools Menu select Options then click Keyboard Mapping. 

2. Find the function for which you want to amend the short cut key and click the existing short cut key. 

3. Click the arrow at the end of the row and select the short cut you require from the list.   
Note: If you select a key combination which is used for another function a warning will appear 
indicating that the short cut is assigned to more that one function. Select a key combination that is 
not assigned to a function. 

 

To restore the default settings: 

1. From the Tools Menu select Options then click Keyboard Mapping. 

2. Click the Reset All button at the bottom right of the screen. 
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Keyboard Actions Configuration 
The Keyboard Actions Configuration tab allows the operator to specify the default action when alphabetic or 
numeric characters are entered. 

 

Default Action for Alphabetic Keystrokes 

There are two actions that can occur when an alphabetic character is entered while a call is active.: 

• Begin Directory Search 
Input is directed to the Directory Search field when the user types an alphabetic character. 

• Open Call Annotation Window 
The Call Annotation Form is presented when the user types an alphabetic character if the cursor is 
not in the Directory Search field. 

 

Default Action for Numeric Keystrokes 

There are two actions that can occur when a numeric character is entered while a call is active.: 

• Begin Directory Search 
Input be directed to the Directory Search field when the user types a numeric character. 

• Open Pop-up Dial Pad 
The Pop-up Dial Pad Form appears when a user enters a numeric character if the cursor is not in the 
Directory Search field. 

 

Call Notes 

This option is only available when in administrator mode. 

You can specify the maximum length of the Call Notes by the number of characters. The length specified 
also applies to the length of messages sent with the Send Message feature.  By default the number of 
characters is set to 16 but the value can be changed to suit the display capabilities of the installed 
telephones. 
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Appearance Configuration 
The operator is able to change the appearance of SoftConsole using the Appearance Option. 

• General:  

• Font: Select the style from the drop down list. 

• Skin: 

• Apply Custom Skin: To change the look of SoftConsole click in the check box. 

• Browse Button: Search for the Skin to apply. 

• Call Status: The Call Information panel frame is color coded to indicate the status of a call.  The 
operator can configure the colors for the status of the call by selecting a new color from the drop 
down list. 

• Idle: The default system color is Black. 

• Alerting - Incoming: The default system color is Red. 

• Alerting - Outgoing: The default system color is Red. 

• Connected: The default system color is Green. 

• Held: The default system color is Blue. 

• Return Call: The default system color is Yellow. 

 

 

Save Configuration 
When changes to the configuration of SoftConsole are made there are two ways to save changes to the 
Profile. 

• Automatically Save Changes to My Profile: When this option is selected any changes made to the 
profile of the operator are saved when the session is ended. 

• Prompt me to Save Changes to My Profile: When the session is ended a dialog box will appear. 
The operator is able to save any changes to their profile or abandon the changes. 
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Appendix 
Cannot send a message. 

Contact your System Administrator.  To be able to send a message the operator's extension needs to be 
configured via Manager to be a System Phone. 

 

Cannot use the 'Force Extension Status' or 'Group Service Status' features. 

There is an interval of several seconds after SoftConsole has been started that the operator cannot use 
these features.  During this interval the Directory Entry Properties or Group Service Status forms will display 
a close button, rather than the OK and Cancel buttons.  Close the form, wait several seconds and then re-
open the form to try again. 

 

Unanswered calls are not returned to the operator  

Contact your System Administrator.  For calls to be returned to the operator when they are not answered,the 
word 'eConsole' (case sensitive) needs to be added in the SourceNumbers tab to the operator's extension in 
Manager. 

 

Microsoft Outlook Warning Screen appears at Login. 

Cause: 

If directory access to Microsoft Outlook contacts folder has been selected in the directories configuration 
form, a Microsoft Outlook warning screen might appear when an operator is opening SoftConsole or using 
the option 'Send Email'.  If the warning screen appears: 

1. Select the Allow access for checkbox, and then click an amount of time in the list. 

2. Click Yes. Yes should always be selected to allow SoftConsole to retrieve Outlook contacts. 

For more information refer to the Microsoft Support web site. 
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How to export Directories. 

Local Directory entries can be exported in a .CSV file format. 

To export the operators Local Directory  

1. From the Directory menu select Export 

2. Enter a name for the file and click OK. 

Note: The directory export facility applies not just to the local directory but to all directories that are shown in 
the directory panel. For example, if only the Show Users Entries button is depressed then only the user 
entries will be exported. If an existing filename is selected the original file contents are overwritten. 

 

How do I delete a Profile. 

Profiles can be removed if they are no longer required by: 

1. From the File menu select Save Profile as. 

2. Select the Profile to be deleted. 

3. Press Delete button. 

4. When all profiles to be deleted have been removed, click Cancel to return to the Main screen. 
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Default Templates 
When the SoftConsole application is installed the following templates are provided. 

 

Template Description 
AdminTemplate1 Panels showing:  

Call Details - Call information & Directory Panel, Queue Panel, Held Calls Panel, 
BLF Panel and Park Slot panel (containing 16 slots) 

 

AdminTemplate2 Panels showing:  
Call Details - Call information & Directory Panel, Queue Panel, Held Calls Panel, 
and Park Slot panel (containing 16 slots) 

 

AdminTemplate3 Panels showing:  
Call Details - Call information & Directory Panel, Queue Panel. 
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Short Cut Keys 
The Default setting for short cut / Hot keys are shown in the table.  If you wish to change any setting, print a 
copy of this table and record the new setting. All functions appear in the category 'All Short Cuts and Hot 
Keys'.  Some functions appear in separate categories as well. 

Note: Press Shift+F1 to view the Help file. 

Function Category Default Setting New Setting 

Add To Conference  Shift+Ctrl+F10  

Add to Conference Room 1  Shift+Ctrl+F11  

Add to Conference Room 2  Shift+Ctrl+F12  

Alternate Calls  Ctrl+A  

Annotate Calls  F11  

Answer Call  Enter  

Answer Held Call Held Call  Ctrl+Alt+A  

Answer the Call On Hold for the Longest Time Held Call  Ctrl+Alt+L  

Arrange BLF Icons by Name BLF  Ctrl+Alt+N  

Arrange BLF Icons by Number BLF  Ctrl+Alt+M  

Arrange BLF Icons by Status BLF  Ctrl+Alt+U  

Arrange BLF Icons Horizontally BLF  Ctrl+Alt+H  

Arrange BLF Icons Vertically BLF  Ctrl+Alt+V  

BLF Details View BLF  Ctrl+Alt+D  

BLF Large Icon View BLF  Ctrl+Alt+G  

BLF List View BLF  Ctrl+Alt+I  

BLF Small Icon View BLF  Ctrl+Alt+S  

Call Selected BLF Group Member BLF  Ctrl+Alt+C  

Call Selected Directory Entry Directory  Ctrl+C  

Call Voicemail Tool  Ctrl+V  

Conference Room 1 Tool  Shift+Ctrl+F4  

Conference Room 2 Tool  Shift+Ctrl+F5  

Conference View Directory  Ctrl+F  

Conference with Held Calls Held  F8  

Create New BLF Group BLF  Ctrl+Alt+R  

Create New BLF Group Member BLF  Ctrl+Alt+B  

Dial Pad Tool  Shift+Ctrl+F3  

Directory View Directory  Ctrl+Y  
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Function Category Default Setting New Setting 

Display Properties of Selected Entry Directory  Ctrl+P  

Edit BLF Group/BLF Group Member Properties BLF  Ctrl+Alt+P  

Hang Up  End  

Hold Call  F4  

Hold the Current Call Against a Busy extension  Ctrl+B  

Hold Call and Auto-Answer the Next Alerting 
Call 

 F7  

Intrude  F9  

Make new call  F12  

New Directory Search Directory  Ctrl+S  

Page  F10  

Park / Unpark Call in Park Slot 1 Park Slots  Alt+F1  

Park / Unpark Call in Park Slot 2 Park Slots  Alt+F2  

Park / Unpark Call in Park Slot 3 Park Slots  Alt+F3  

Park / Unpark Call in Park Slot 4 Park Slots  Alt+F4  

Park / Unpark Call in Park Slot 5 Park Slots  Alt+F5  

Park / Unpark Call in Park Slot 6 Park Slots  Alt+F6  

Park / Unpark Call in Park Slot 7 Park Slots  Alt+F7  

Park / Unpark Call in Park Slot 8 Park Slots  Alt+F8  

Park / Unpark Call in Park Slot 9 Park Slots  Alt+F9  

Park / Unpark Call in Park Slot 10 Park Slots  Alt+F10  

Park / Unpark Call in Park Slot 11 Park Slots  Alt+F11  

Park / Unpark Call in Park Slot 12 Park Slots  Alt+F12  

Park / Unpark Call in Park Slot 13 Park Slots  Shift+F9  

Park / Unpark Call in Park Slot 14 Park Slots  Shift+F10  

Park / Unpark Call in Park Slot 15 Park Slots  Shift+F11  

Park / Unpark Call in Park Slot 16 Park Slots  Shift+F12  

Pickup Call From Queue 1 Queue Mode  Shift+F1  

Pickup Call From Queue 2 Queue Mode  Shift+F2  

Pickup Call From Queue 3 Queue Mode  Shift+F3  

Pickup Call From Queue 4 Queue Mode  Shift+F4  

Pickup Call From Queue 5 Queue Mode  Shift+F5  

Pickup Call From Queue 6 Queue Mode  Shift+F6  
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Function Category Default Setting New Setting 

Pickup Call From Queue 7 Queue Mode  Shift+F7  

Pickup Call From Queue 8 Queue Mode  Shift+F8  

Reattempt the Transfer of a Returned Call  Ctrl+R  

Reclaim Call  F6  

Record Call  F5  

Release Door 1 Tool  Shift+Ctrl+F1  

Release Door 2 Tool  Shift+Ctrl+F2  

Restore SoftConsole Application Application  Pause  

Send Email to Selected User Directory  Ctrl+E  

Send Message to Selected User Directory  Ctrl+M  

Show/Hide Directory Entries Directory  Ctrl+D  

Show/Hide Group Entries Directory  Ctrl+G  

Show/Hide User Entries Directory  Ctrl+U  

Switch Between Normal View Mode and 
Compact View Mode. 

Application  Home  

Transfer Call  F2  

Transfer Complete  Ctrl+T  

Transfer Held Call Held Call  Ctrl+Alt+T  

Transfer to Voicemail  F3  
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Toolbar Buttons 
Main Toolbar 

 
Login 

 
Save Profile 

 
New Call 

 
Answer Call 

 
Hold Call 

 
Transfer Call 

 
Transfer Complete 

 
Reattempt Transfer 

 
Conference 

 
Hang up 

 
Page 

 
Record Call 

 
Compact View 

 
Dial Pad 

 
Access Conference Room 1 

 
Access Conference Room 2 

 
Options 

Call Details - Directory Panel  

 
Make a call to the selected Directory Entry 

 
View the Directory Properties for the selected Entry 
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View Directory Items 

 
View Active Conferences 

 
Show/Hide User Entries 

 
Show/Hide Group Entries 

 
Show/Hide Directory Entries 

Held Calls Panel 

 
Answer the Selected Held Call 

 
Answer Longest Held Call 

 
Conference with Held Calls 

 
Transfer Held Call 

 



 Page 63 

SoftConsole Users Guide Page 63 
IP Office 40DHB0002USEJ Issue 1 (23rd September 2003) 

Glossary 
DSS Keys        Keys that can be programmed to allow users to see which lines/extensions are busy/free at 

a glance.   

 

Hunt Group     A Hunt Group is a group of users created to take specific calls, e.g. "Main" to take incoming 
calls to the switchboard, "Sales" to sales orders, "Support" to handle help desk calls, etc. 
To create a Hunt Group, see your System Administrator. 

 

Profile               A profile contains information on the configuration preferences and connection to the 
telephone system.  Each user can create their own profile 

 

Template          A template contains a predefined layout and configuration options.  Templates can be used 
to create a user profiles. 
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